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SUMMARY 
 

Welcome to SIMEDIF! This short manual will try to give you an overview of the possibilities offered 

by SIMEDIF, what you can do with the software and what you cannot do. At the end of this 

manual, we include an example of application, in order to facilitate your first contact with 

SIMEDIF. 

 

SIMEDIF is a design tool to calculate the hourly air temperature inside the spaces of a building, the 

hourly surface temperature of walls, and the hourly auxiliary heating/cooling energy that is 

needed to maintain the spaces at a constant setpoint temperature. It allows you to analyze the 

building behavior in different climatic conditions, to detect problems of thermal comfort 

(overheating or low temperatures), to evaluate possible alternatives in the design of a building, 

such as variations in its geometry, orientation, location and size of glazed areas, structure and 

materials of the envelope, the addition of passive and hybrid systems, etc. In existing buildings the 

software can be used to validate the building model through measured data, or to quantify the 

effectiveness of possible alternatives for redesign. 

 

This version for Windows was developed by Dr. Silvana Flores Larsen at INENCO (Research 

Institute of Non-Conventional Energy, U.N.Sa.-CONICET). The original 1984 version for DOS was 

developed by Drs. Graciela Lesino, Luis Saravia and Dolores Alía. The present version is an 

adaptation of the original Spanish version made with VisualBasic 6. Currently, a new one is being 

developed in Python, which will include improvements and new modules for comfort calculation, 

green walls, and so on. 

DOWNLOAD AND INSTALLATION 
The software and updates can be downloaded for free from the Internet: 

http://exactas.unsa.edu.ar/simedif/En/ 

 

Requirements (not much!): 

Windows XP and 8 MB of free hard disk space 

Internet: not required 

 

For Windows Vista and 7 please check if you need to install the additional software. 

 

Once you have downloaded the Setup on your PC, you can install it automatically by unpackaging 

the file and by making double-click on the Setup executable file. Once installed, you can find the 

software on the Windows Start button (Start- > Programs -> SIMEDIF). There you will also find this 

manual in pdf format and a folder with Weather data files. 

 

VERY IMPORTANT NOTE: For the software to work correctly, the OS setting for decimal numbers 

must use a point and not a comma (for example: 1.2 is the correct number format). To change the 

Windows setting of the numbers, go to Start-> Control Panel -> Regional Settings and Language -> 

Regional Options, click the "Customize" button and there choose: 

1. "Decimal symbol" point (if it is not among the options, simply type the a point in the keyboard). 

2. In "Symbol for separating thousands" select comma. Click "OK" to save the changes. 
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1. INTRODUCTION TO SIMEDIF 
 

BEFORE STARTING…SOME IMPORTANT COMMENTS 

 

SIMEDIF does not replace the architect or designer of a building, but it helps him/her take design 

decisions to improve the thermal behavior and consumption energy of the building. That is why 

the program: 

 Does not check whether the entered values are correct (for example, thermophysical 

properties, or heat transfer coefficients). 

 Does not analyze or interpret the results. It is essential the interpretation of results by the 

user to detect mistakes in data entry. 

 It is required the user to have a previous basic knowledge of the fundamentals of heat 

transfer in buildings in order to use properly SIMEDIF. 

 

The software was designed to simplify the entry data, so the final decision on what elements 

should be used to describe the building is left to the user. A wrong choice in data entry will 

produce wrong results. 

Some tools have been added to simplify the control of data: 

 SIMEDIF can detect some typing errors (e.g. writing letters instead numbers, empty fields, 

etc.) and it alerts the user about these errors. 

 SIMEDIF provides a material database to help the user, which should be checked in each 

country. This database can be modified to include the own user materials, if needed. 

 SIMEDIF is a perfectible software (so a Beta version is distributed test), coded at the 

moment by only one person, so errors will occasionally appear during use. In the last 

years, it has been improved with the help of the users, so your comments will be 

welcome!. 

 

A LITTLE BIT ABOUT THE HISTORY OF SIMEDIF 

 

The name “SIMEDIF” is a contraction between two Spanish words (“Simulación”-Simulation, and 

“Edificio”-Building). Early SIMEDIF was born in 1984 at the Institute for No Conventional Energy 

Research (INENCO, UNSA-CONICET) of the National University of Salta and CONICET, Argentina, as 

a DOS software. The original programming language was the old GW-Basic (Casermeiro and 

Saravia, 1984). It was used in the ’80 by research groups around the country, so SIMEDIF was 

largely validated throughout years of experimental work in Argentina by numerous groups that 

have used it for research, design, and simulation of the thermal behavior of buildings (Caso et al., 

1986; Binda and Lesino, 1987; Hernández and Lesino, 1993; Reyes and Evans, 1993; Esteves et al., 

1994; Beascochea and Filippín, 1998; Hernández et al., 1999; Hernández and Lesino, 2000). In all 

cases, comparison between the simulated transients of temperature and the experimental data 

confirmed the reliability of the numerical code. 

 

Throughout the years and with the arrival of Windows, the software code became obsolete, so it 

was to be recoded, around the year 2000. The new version, for Windows, was improved by 

including new elements that allowed a more detailed simulation of the building (e.g., the inclusion 

of doors, the possibility of defining internal gains in each thermal zone, evaporative cooling 



 

systems, earth tubes, a primitive plot tool, 

successfully simulated by SIMEDIF grew

quickly spread to several research groups in Argentina and other countries

As a result of this effort, SIMEDIF became 

complexity of other (very good and complete) existing softwares. It is an ideal tool for 

experienced users and an excellent tool

 

Many people worked during decades i

was developed by Dr. Luis Saravia, Dr. 

Windows version and the inclusion of new calculation modules w

Flores Larsen. The program is freely available on the Internet

from where you can download the latest

 

WHAT CAN SIMEDIF DO?

 

Currently, what SIMEDIF can do is:

 

 It can simulate the hourly 

temperatures of wall surfaces.

 It can help you detect thermal 

 It is a design tool that allows 

and climates. 

 It can calculate two hybrid systems

 It can calculate the heating/cooling power 

temperature. 

 

WHAT CANNOT SIMEDIF DO?

 

Currently, what SIMEDIF cannot do is:

 

 It does not include mass transfer (humidity calculations).

 It does not calculate natural lighting.

 It does not check data entry values (only a few basic controls like empty fields, zero values, 

etc.). 

 It does not interpret the results.

 It does not replace the building designer.

 

Fig. 1: SIMEDIF is not intelligent. If you en
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, a primitive plot tool, etc.). The number of buildings modeled, monitored and 

simulated by SIMEDIF grew due to the good results obtained using the program and 

l research groups in Argentina and other countries. 

As a result of this effort, SIMEDIF became a software easy-to-use (and lern) ,

complexity of other (very good and complete) existing softwares. It is an ideal tool for 

experienced users and an excellent tool for teaching. 

Many people worked during decades in the development of the software. The original DOS 

by Dr. Luis Saravia, Dr. Graciela Lesino and Dr. Dolores Alía de Saravia.

Windows version and the inclusion of new calculation modules were developed 

Flores Larsen. The program is freely available on the Internet (http://exactas.unsa.edu.ar/simedif/

from where you can download the latest updates. 

WHAT CAN SIMEDIF DO? 

Currently, what SIMEDIF can do is: 

hourly temperature of the spaces of a building and the hourly 

temperatures of wall surfaces. 

It can help you detect thermal comfort problems. 

that allows testing different materials, orientations, building geometry, 

hybrid systems: evaporative coolers and earth tubes. 

heating/cooling power required to reach a pre-defined indoor 

WHAT CANNOT SIMEDIF DO? 

Currently, what SIMEDIF cannot do is: 

It does not include mass transfer (humidity calculations). 

calculate natural lighting. 

It does not check data entry values (only a few basic controls like empty fields, zero values, 

It does not interpret the results. 

It does not replace the building designer. 

Fig. 1: SIMEDIF is not intelligent. If you enter wrong data, the results will be wrong too.

 

modeled, monitored and 

due to the good results obtained using the program and 

use (and lern) , without the 

complexity of other (very good and complete) existing softwares. It is an ideal tool for non-

original DOS version 

de Saravia. The 

developed by Dr. Silvana 

http://exactas.unsa.edu.ar/simedif/) 

and the hourly 

different materials, orientations, building geometry, 

defined indoor 

It does not check data entry values (only a few basic controls like empty fields, zero values, 

 
ter wrong data, the results will be wrong too. 
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HOW TO SIMULATE A BUILDING IN SIMEDIF 

 

You have to follow the steps of the following scheme: 

 
Fig. 2: Steps of data entry and calculation with SIMEDIF. 

 

Step 1: Enter the site and weather data and simulation period. 

By clicking in Edit->Site and simulation, a screen will ask you to enter the name of the weather file. 

SIMEDIF reads TMY3 files
1
. You can use your own files or the files provided with the installation, 

which are included in the folder “Climate”. Once you selected the weather file, you must select the 

number of days to simulate (from 1 to 365), and the first day of simulation, in case the number of 

days is lower than 365. Then click on “Save file” button. You will be asked for a file name to save 

the data. 

 
Fig. 3: Screenshot of data entry for site, weather and simulation period in SIMEDIF. 

 

                                                           
1
 For help about TMY3 format, please go to NREL web page, http://www.nrel.gov/docs/fy08osti/43156.pdf 

Site and 
weather

Thermal
zones

Connecting
elements

Make
calculation



 
8 

 

Step 2: Divide the building into thermal zones. 

A thermal zone is a volume of air that can be considered at a uniform temperature. A thermal 

zone can be a space, part of a space, or a group of spaces. The software will calculate the 

evolution in time of the temperature of each thermal zone, by making an energy balance on the 

air volume. The zone can be either, forced to have a uniform temperature (in this case, a value of 

the thermostat setpoint temperature must be defined by the user) or allowed to freely fluctuate. 

For each thermal zone you must enter:  

1. Name of the thermal zone: a representative name for the space.  

2. Air Volume (in m
3
) 

3. Air renewals (in average): this value is used for all the hours of the simulation 

4. Thermostatized (yes/no, and thermostat temperature) 

 

Then click on “Save file of thermal zones”. 

 

 
Fig. 4: screenshot of data entry for Thermal zones. 

 

Step 3: Connect the thermal zones with elements. 

Each thermal zone can be connected to another thermal zone or with the outdoor environment. 

This connection is performed through building elements (if you not define any element, there is no 

connection of this type between thermal zones). These elements in SIMEDIF are of two kinds: 

 

� Solid elements: MASSIVE WALLS, PARTITIONS, GLAZING, and WATER WALLS. 

� Air-to-air connections: DOORS and VENTS (one-directional or bi-directional air 

exchange). 

 

Each element has properties and characteristics that must be defined in the corresponding screen. 

You can access the elements through ‘Edit’. Table 1 shows the fields to be filled for each element. 

A breaf description of the physical modeling of each element is given in the following section. 
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Fig. 5: data entry for MASSIVE WALLS, one of the connecting elements of SIMEDIF. 

 

 

MASSIVE WALL PARTITION WATER WALL GLAZING DOOR AIR 

MIXING 

VENT 

Area (m
2
) Area (m

2
) Area (m

2
) Area 

(m
2
) 

Height 

(m) 

Area (m2) 

Sunlit area (m
2
) Sunlit area (m

2
) Sunlit area (m

2
) U-value 

day 

(W/m
2
-

K) 

Width (m) Height 

(m) 

Solar absorptivity Solar absorptivity Solar absorptivity U-value 

night 

(W/m
2
-

K) 

Discharge 

coefficient 

Discharge 

coefficient 

Orientation 

indicator 

Orientation 

indicator 

Orientation 

indicator 

   

Convective/radiative 

coefficient (W/m
2
-K) 

Convective/radiative 

coefficient (W/m
2
-K) 

Convective/radiative 

coefficient (W/m
2
-K) 

   

Nº of layers & 

properties 

Thermal 

conductance 

(W/m
2
-K) 

Thickness (m)    

Table 1: Properties of each element. 

 

ORIENTATION INDICATORS 

While not strictly an “element” of connection, the ORIENTATION INDICATORS will be described 

here. 

 

Orientation is important for solar radiation. For example, in the South hemisphere, a 

MASSIVE WALL oriented towards the North receives more solar radiation than other 

oriented towards the South. Because the data entry in SIMEDIF is not graphical, we have 
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to indicate manually the orientation of each element. This orientation together with the 

number of transparent covers the radiation overpasses until reaching certain surface, are 

described by the ORIENTATION INDICATORS. Thus, the software calculates the solar 

radiation that reaches the different surfaces depending on their orientation. This 

calculation uses the hourly global horizontal, diffuse and direct solar radiation data (read 

from the weather file). For defining an ORIENTATION INDICATOR you must enter: the 

slope of the surface (from 0º to 90º), the azimuth of the surface (0º towards South, 90º 

towards East, 180º towards North, and 270º towards West), the albedo, and the number 

of transparent covers. For example: a MASSIVE WALL oriented to North, on the outside, 

we will define the ORIENTATION INDICATOR Nº1, with slope 90º, azimuth 180º, albedo 0.3 

(surroundings covered by grass), and Number of transparent covers 0. This ORIENTATION 

INDICATOR can be used for all the elements with the same configuration (for example, a 

PARTITION oriented towards North, another MASSIVE WALL with the same orientation, 

etc.). 

 

A MASSIVE WALL (or a PARTITION) can be illuminated in one or in its two sides (for 

example, an exterior wall with a window in front of it that illuminates the interior side of 

the wall). Thus, the ORIENTATION INDICATORS must be defined for both sides of the 

element. 

 

Step 4: Make calculations 

Once all the elements were described, the calculation is made by selection “Make calculation” in 

the “Calculate” menu on the toolbar. This launches: 

 

1. A control step of all data entry. If any problem with data is detected (for example, 

negative/missing values, typing error, etc.), a warning message is shown. In this case, a 

window will alert about the error and the element where this error was detected. 

2. A calculation based on meteorological data is made. SIMEDIF calculates the hourly solar 

radiation corresponding to each of the ORIENTATION INDICATORS. To do this, solar global 

on horizontal surface, solar diffuse on horizontal surface and solar direct (beam) radiation 

is read from the meteorological TMY3 file.  Then a conversion to the plane orientation is 

made and finally the effect of glazing covers on the transmitted solar radiation is 

calculated. A text file with extension *.rrr is created, that contains the hourly total solar 

radiation calculated for each ORIENTATION INDICATOR and the hourly temperature. 

3. A calculation of the heat transfer coefficients for each element is made. Each element 

contributes to the heat transfer between zones via a heat transfer coefficient. This 

coefficient is calculated from the geometry and thermal properties of the element. For 

details about them, please go to the section about physical modeling. 

4. A heat balance for each zone is performed. Firstly, a heat balance on massive nodes is 

performed (nodes of massive walls and water walls). Once the convergence is achieved, 

the calculation on air nodes is performed. The results are saved in a text file with 

extension *.res. This file is used to generate a plot. 
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2. DESCRIPTION OF THE CONNECTING ELEMENTS IN SIMEDIF 
 

2.1.MASSIVE WALL 

A MASSIVE WALL is an opaque building element with thermal mass which connects two thermal 

zones. It is involved in the thermal storage and allows the calculation of the transient conduction 

effects. Heavy construction elements are considered MASSIVE WALLS (even the floor and the roof, 

if they are massive). A wall can have one or several successive layers of different materials. The 

number of layers and materials are defined in WALL LAYERS section. Each layer may be massive or 

not, except the two layers at the beginning and at the ending of the wall, which must have mass 

For each side of a MASSIVE WALL the following properties are needed: total wall area and sunlit 

area, solar absorption coefficient, convective coefficient, and orientation indicator. A heat balance 

is performed in the wall that considers solar absorption, convective/radiative heat transfer to air, 

and heat storage in the thermal mass of the wall. Each layer of the wall is divided into slices 

(whose number is defined by the user in WALL LAYERS section). A heat balance is made for each 

slice by using the electrical-thermal analogy (in walls, this model includes resistances and 

condensers). The thermal contact between the wall surfaces and room air is described by means 

of complexive convective-radiative heat transfer coefficients. The wall surface may or may not 

receive solar radiation (the solar absorption coefficient and the sunlit area describes this 

phenomenon). 

� Total wall area: the area involved in the heat transfer (one side of the wall), m
2
. 

� Sunlit wall area: the area of the wall which receives solar radiation (m
2
). It should be 

estimated as an average value in the day. The interior wall surfaces can receive solar 

radiation from a window. In this case, the sunlit area is the window area and the 

ORIENTATION INDICATOR is related to the window geometry and material. 

� Solar absorption coefficient: it is the absorptivity of the surface in the solar spectrum. 

� Convective heat transfer coefficient: it is the heat transfer coefficient that accounts for 

convection and radiation (a linearized coefficient), in W/(m
2
-K). A usual way of estimating 

it is: h= 5.7 + 3.8xV, where V is the wind speed in m/s (Duffie and Beckman, 2005). 

� Orientation indicator: the indicator defined in ORIENTATION INDICATOR section that 

describes orientation of the wall and the number of transparent covers that solar radiation 

crosses in its way to the wall surface. If sunlit area is 0, the ORIENTATION INDICATOR has 

no effect. 

 

NOTE: in SIMEDIF, floors in direct contact with ground are defined as MASSIVE WALLS. They can 

have different layers, but the last one must be the ground (of around 1m of thickness). For the 

ground side, 0 sunlit area is used, and the convective/radiative coefficient must be very small (for 

example, 0.001 W/m
2
-K, because a zero value will return an error of “Division by zero”). 

 

2.2. PARTITION 

It is an opaque building element with parallel faces with relatively small thermal mass. Some 

examples are interior gypsum partitions, wood panels, insulating panels, metal sheets, etc. Doors 

always closed should be described by a PARTITION. For a PARTITION the following properties are 

needed: total wall area and sunlit area, solar absorption coefficient, convective-radiative 

coefficient, orientation indicator, and thermal conductance (that is, the inverse of the thermal 

resistance). 



 
12 

 

 

2.3. WATER WALL 

Tank of parallel faces, with total thickness “d” (or cylindrical with equivalent diameter “d”), filled 

with water and placed in front of a solar aperture. Water is mixed by natural convection and 

therefore a uniform temperature of the whole water mass is assumed. There is some question 

about how isothermal the water is in tanks, but vertical stratification is considered to have little 

influence on performance (Balcomb, 1992). 

 

2.4. GLAZING 

It is an element connecting two zones by means of thermal transmission coefficients that can vary 

from day to night. This allows simulating night insulation due to the use of wickets, curtains, roll-

down blinds, etc. The GLAZING elements are neither associated to solar gain (which in fact must 

be considered in the sunlit area of the wall receiving the solar radiation that enters through the 

window) nor to ventilation (which is considered in the air renewals of the THERMAL ZONE where 

the window belongs to). 

 

2.5. DOOR AIR MIXING 

A DOOR AIR MIXING is an opening between thermal zones that could have different air 

temperatures. Both zones should be at the same elevation. Thus, there is air exchange between 

zones by natural convection (air mixing), due to the difference of air density between the two 

THERMAL ZONES. Its dimensions correspond to the dimensions of the opening. The heat transfer 

coefficient is a function of the temperature difference between the zones connected by the door 

under consideration (see the description of DOORS in the Physical Model section). The file with the 

description of the doors of a building is saved with the extension * .pue. A permanently closed 

door does not allow convective exchange between thermal zones, so it should represented by a 

PARTITION. The increase or decrease the flow of air through the door opening because of 

geometrical factors (as the shape of vain or position of the door sheet) are taken into account 

through the discharge coefficient ranging between 0 and 1, which depends on the Reynolds 

number. An indicative value for this coefficient is 0.6. The period when a door is opened -allowing 

the convective exchange between the thermal zones- is entered into the boxes Opening hour and 

Closing hour (both integer numbers). This value cannot be a decimal one: if you enter 8 as Opening 

hour and 8.2 as Closing hour, the code will considers that door is open between 8:00 to 9:00. 

 

The DOOR AIR MIXING element has the following characteristics: 

� Height: it is the height of the door opening (m). 

� Width: it is the width of the door opening (m). 

� Discharge Coefficient: the discharge coefficient accounts for the increase or decrease the 

flow of air through the door opening because of geometrical factors (as the shape of vain 

or position of the door sheet). An indicative value for this coefficient is 0.6. 

� Opening hour: time when the door becomes open (integer, from 0 to 23). 

� Closing hour: time when the door becomes closed (integer, from 0 to 23). 
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2.6. VENTS 

VENTS are paired openings on the top and bottom of a wall that allow the air circulation from a 

hotter zone to a colder one due to natural convection. They are used in vented Trombe walls. 

Their characteristics are the opening area and the distance between the top and bottom vent 

centers. Vents work as thermal diodes and are important in Trombe wall description. The air 

movement is unidirectional (from hotter to colder zone), unlike a door, in which the convective 

exchange is bidirectional. For a VENT the following properties are needed: THERMAL ZONE of the 

top vent (the zone heated by the airflow during daytime), area (m
2
), height between gap centers 

(m), and discharge coefficient (usually 0.6). 

 

3. PHYSICAL MODEL OF A BUILDING IN SIMEDIF 

3.1. Assumptions and simplifications of the model 

The physical model of a building in SIMEDIF has been developed under the following assumptions:  

 

� The heat fluxes through the walls are considered unidirectional.  

� The heat transfer between the indoor air and the inner surfaces of massive walls, water 

walls, and Partitions is of convective/radiative nature. 

� The convective-radiative heat transfer coefficients of the surfaces account for convection 

and radiation. Radiation is therefore linearized. 

� No view factors are taken into account in the computation of radiant energy exchange 

between surfaces. 

� The temperature distribution at the starting time is known. For the first time step, the soft 

considers that all the building (spaces and elements) are at the mean outdoor air 

temperature. 

� Solar incident radiation on any wall is uniformly spread over the entire wall surface.  

� Mass balances are not considered (humidity is not calculated). 

 

The simulated building is divided by the user into “thermal zones”. A “thermal zone” is a building 

space that can be considered isothermal (thus a zone can be a group of various rooms in the 

building or a part of a room). Thus, each zone has a unique temperature whose hourly evolution is 

determined by the software, using the building data, materials, site, orientation, outdoor 

temperature, and solar radiation in the simulation period. The thermal zones are connected to 

each other and with the environment by elements that have any of the following thermal 

characteristics: 

 

� Storage and heat transfer by conduction, such as brick walls, adobe walls, concrete walls, 

etc. These elements are called massive walls.  

� Storage into a uniform temperature mass such as water walls where the water is supposed 

to convect and has a uniform temperature.  

� Heat transfer by conduction without storage, such as wood, expanded polystyrene, etc. In 

SIMEDIF, these elements are called lightweight walls.  

� Heat transfer by conduction with two heat transfer coefficients (day and night), such as 

windows with night insulation. These elements are called windows, and they do not 

describe to solar gain or ventilation.  
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� Heat transfer by convection, such as openings in the walls that allow a convective air 

exchange. These elements are DOORS and VENTS in SIMEDIF.  

 

Each thermal zone is an “air” node. For each element, nodes are defined in surfaces (“surface” 

nodes) and in massive and water walls extra nodes are defined in the interior (for example, in a 

wall, the user can select the number of slices used to divide the wall). Thus, an energy balance at 

each node is made, for which the temperature is to be determined.  

 

3.2. Energy balance for massive nodes 

Typically, a MASSIVE WALL is represented as one dimensional and it is sliced into a number of 

layers of thickness ∆x (inner nodes) and ∆x/2 (edge nodes). The inner and surface massive nodes 

of a wall are separately analyzed (see Figure). 

 

 
Fig. 6: discretization of a MASSIVE WALL. Each dark circle inside the wall is a “node”. 

 

The energy balance on the inner nodes gives: 

 

 
while an energy balance on the left surface node gives: 

 
 

A similar expression is obtained for the node on the right surface. 

 

In the case of a WATER WALL, only one node is used (see Fig.), representing the temperature of 

the whole water mass. 



 

 

Fig.

 

In a WATER WALL, the heat balance is:

 

 

 

 

 

 

 

 

The finite-difference explicit method is used to replace the time and spatial derivatives by finite 

differences. The result is a set of equations for 

can be evaluated from temperatures at the previous time 

initial value problem. Initial conditions, consisting of the starting storage mass temperatures and 

air temperatures, are needed (usually the average outdoor air temperature is used)

 

3.3. Energy balance for non

There are two kinds of non-massive nodes: the nodes on 

temperatures at the nodes of 

between the node and the air into a single conductance. 

 

Fig.
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Fig. 7: heat transfer on a WATER WALL. 

, the heat balance is: 

difference explicit method is used to replace the time and spatial derivatives by finite 

e result is a set of equations for m massive nodes. The temperature at time 

can be evaluated from temperatures at the previous time t. This set of equations constitutes an 

initial value problem. Initial conditions, consisting of the starting storage mass temperatures and 

are needed (usually the average outdoor air temperature is used)

non-massive nodes 

massive nodes: the nodes on PARTITIONS and the nodes on air. The 

temperatures at the nodes of PARTITIONS can be eliminated by combining the conductances 

between the node and the air into a single conductance.  

 
Fig. 8: heat transfer on a PARTITION. 
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In a PARTITION, the heat balance is:

 

 

 

 

 

 

Fig. 9: DOORS

 

For DOORS, the bi-directional air exchange leads to a heat transfer between 

given by: 

 

 

 

 

 

 

 

 

For VENTS, the one-directional air exchange leads to a heat transfer between 

given by: 

 

 

 

 

 

 

 

 

 

The energy balance for an air node, referred to the control volume of the zone, considers energy 

contributions due to indoor heat sources, and losses and gains due to the elements which connect 

a THERMAL ZONE to another one
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, the heat balance is: 

DOORS (left) and VENTS (right) in a Trombe wall. 

directional air exchange leads to a heat transfer between THERMAL ZONES

directional air exchange leads to a heat transfer between THERMAL ZONES

The energy balance for an air node, referred to the control volume of the zone, considers energy 

contributions due to indoor heat sources, and losses and gains due to the elements which connect 
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THERMAL ZONES 

THERMAL ZONES 

The energy balance for an air node, referred to the control volume of the zone, considers energy 

contributions due to indoor heat sources, and losses and gains due to the elements which connect 
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In this equation the summatory in k indicates a sum over all THERMAL ZONES k in contact with the 

THERMAL ZONE i., and the supraindex t indicates the hourly value for the referred quantity.  

 

Ulw,j,i, Cvent,j, Cdoor,j, fraclw,i,k and Clw,j are given by the following expressions: 

 

 
The energy balance must repeated for each building THERMAL ZONE. The result is a set of 

equations for n non-massive nodes. Thus, a system with as many equations as unknown variables 

is obtained and solved with the usual numerical techniques. Because of the non-linearity of the 

coefficients, iterations are performed until the convergence is achieved. 

 

The calculation method consists of an explicit finite difference scheme advancing in ∆t steps, with 

∆t a submultiple of one hour (its value is chosen during the data input). The results are saved hour 

by hour in a file. By using the temperature values at time t and the finite difference explicit 

method, the temperatures at t + ∆t in the massive nodes are calculated. These temperatures are 

introduced in the system of non-massive nodes to obtain the temperatures at t + ∆t. Once all the 

nodal temperatures are estimated, a balance of the heat gain provided by the solar radiation, the 

heat loss of the building, and the heat accumulated in the different masses is performed. These 

calculations allow the detection of possible problems with the input data. 

 

The use of the explicit finite difference scheme restricts the possible values of ∆t to avoid 

oscillations in the numerical solutions. This instability causes the calculated node temperatures to 

oscillate with increasing error in each step, which is a common error when using finite-difference 

algorithms.  
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4. EXAMPLE 1: Simulation of a building with two thermal zones. 

 

Take a look at the building of the Figure. It is a small house with a livingroom, a bathroom 

and a bedroom, placed in Salta city, in the North of Argentina. Exterior walls are 3-layered 

(massive ceramic brick 0.12m thick + expanded polystyrene 0.05m + massive ceramic brick 

0.12m). The interior partitions between spaces are made of gypsum board (gypsum board 

0.02m thick + air camera 0.05m thick + gypsum board 0.02m thick). The roofing 

construction – from outdoors to indoors- is a galvanized iron sheet with 0.045m of 

thermal insulation (expanded polystyrene) and pine wood. Floor is a concrete layer (0.1m 

thick) on the ground, with a ceramic gray cover (0.005m thick). Interior walls are painted 

with beige color. Wood doors are 2m height, 0.8m width and 0.045m thick. Both windows 

have double glazing (glass 4mm + air camera 6mm + glass 4mm) and they are 2m x 1m. 

The window in bedroom has a wood shutter that remains closed during the night. We 

want to know the thermal of the building in winter (June) and in summer (December). 

 

 

 

Fig. 1: building of the example. 
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4.1. Step 1: Enter the site and weather data and simulation period. 

Click on File ->New file and type a generic name for the group of files of the simulation. The file 

name (in this case, “example1”) will appear in the top of the SIMEDIF screen. All future files for 

this simulation will be named with this name and with different extensions. When you open an 

existing file, you can click on any of them; all the files will be read and loaded in SIMEDIF. 

By clicking in Edit->Site and simulation, a screen will ask you to enter the name of the weather file. 

In this case, we select the file for Salta city (see Fig). The software reads the file and completes 

data of latitude, longitude, altitude, and time zone. The air density is automatically calculated from 

the altitude value. 

 

In “Simulation period” frame you can select the number of days to simulate and the first day of 

simulation. In this case, we could simulate 365 days starting on January 1
st

, or all the days of June 

and then, in a new simulation, all the days of December
2
. There are two reasons to simulate the 

building once by month. The first one, because of the calculation time (it is higher if you simulate a 

whole year). The second one, and more important, because a unique constant value is used for the 

air renewals in the THERMAL ZONES, which could be not the case if you want different ventilation 

levels in winter than in summer. 

 

Once entered the data, you must click on “Save file” to save the data of this screen. If you did not 

enter previously a file name, you will be asked for a file name and folder. A new file example1.gen 

will be created. 

 

 
Fig. 2: Site and simulation screen. 

                                                           
2
 Current SIMEDIF version does need to enter a few previous days of simulation to reach the conditions of 

the first day of simulation you want. Usually it is around 10-12 days for massive buildings and around 3-5 

days for lightweight buildings. Thus, if you are interested in simulating June, the first day of simulation 

should around May 15
th

. 

When the format of numbers in Windows is not correct, a warning message will appear when 

you try to save the file. Check “Download and installation” section to fix the error. 
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4.2. Step 2: Divide the building into thermal zones. 

In this example we could simulate three THERMAL ZONES (Bathroom, Bedroom, and Living 

room). Because we want a quicker approach to the building thermal behavior, we could 

simulate two THERMAL ZONES or even only one for the whole building. We will work in 

this case with two THERMAL ZONES (one for the Living room and one for the 

Bedroom/Bathroom). The geometry of each THERMAL ZONE is shown in the following 

Table 1. 

 

THERMAL ZONE name Width Length Height Volume Air renewals 

Living_room 5m 4m 2.5m 50 m3 2 (1/h) 

Bedroom/bathroom 3m 4m 2.5m 30 m3 2 (1/h) 

Table 1: geometry of the THERMAL ZONES and air renewals assumed for each one. 

The data for THERMAL ZONES is entered by clicking in Edit->Thermal zones, as shown in 

Fig. 3. Five zones appear by default. You have to delete the non-used zones. Because we 

will calculate the indoor temperature without thermostatizing, we don’t enter a value for 

the thermostat. Once all the data was entered, you must click on “Save file of Thermal 

zones” button. This action will create a new file named example1.loc. 

 

 

Fig. 3: THERMAL ZONES screen. 
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4.3. Step 3: Connect the thermal zones with elements. 

The following step consists in detecting the type of element that connects the THERMAL 

ZONES. Usually you will need a plane of the building, where you will detect the elements. 

In this example, we have seven MASSIVE WALLS (the walls of the envelope which are of 

massive brick, and the floor, which in SIMEDIF is defined as a MASSIVE WALL because it is 

in direct contact with ground), which are named from M1 to M7 in Fig. 4 (colors identify 

the elements). We have two doors (D1 and D2) and two glazed windows (G1 and G2). Also 

we have three PARTITIONS: an interior partition N1 and two roofs (N2 and N3). A list of 

the elements and their sizes is shown in Table 2. 

 

 

Fig. 4: scheme of the elements of the building (M: MASSIVE WALLS, N: PARTITIONS, D: 

DOORS, G: GLAZING). 

 

Element Connecting: Size Area 

MASSIVE 

WALLS 

M1 Outdoors-Bedroom/Bathroom 3m x 2.5m 7.5 m
2
 

M2 Outdoors- Bedroom/Bathroom 3m x 2.5m 7.5 m
2
 

M3 Outdoors- Bedroom/Bathroom 4m x 2.5m-G2 8 m
2
 

M4 Outdoors- Bedroom/Bathroom 3m x 4m 12 m
2
 

M5 Outdoors-Living_room 5m x 2.5m - G1 10.5 m
2
 

M6 Outdoors- Living_room 4m x 2.5m-N4 8.4 m
2
 



 
22 

 

M7 Outdoors- Living_room 5m x 2.5m 12.5 m
2
 

M8 Outdoors- Living_room 5m x 4m 20 m
2
 

PARTITIO

NS 

N1 Bedroom/Bathroom – Living_room 4m x 2.5m - D1 8.4 m
2
 

N2 Outdoors- Bedroom/Bathroom 3m x 4m 12 m
2
 

N3 Outdoors- Living_room 5m x 4m 20 m
2
 

N4 Outdoors- Living_room 0.8m x 2m 1.6 m
2
 

GLAZING 
G1 Outdoors- Living_room 2m x 1m 2 m

2
 

G2 Outdoors- Bedroom/Bathroom 2m x 1m 2 m
2
 

DOORS D1 Bedroom/Bathroom – Living_room 0.8m x 2m 1.6 m
2
 

Table 2: elements of the building and their sizes. 

 

4.3.1. MASSIVE WALLS: you have seven MASSIVE WALLS. Thus, M1 is the wall of the 

Bedroom/Bathroom facing North, while M5 is the wall of the Living_room facing North. 

They belong to different THERMAL ZONES, so we need to split the whole wall in this two 

M1 and M5. With the same reasoning, the building floor is splitted into two MASSIVE 

WALLS: M4 is the floor of the Bedroom/Bathroom (that is, it connects this zone with 

outdoors) and M8 is the floor of the Living_room. For each wall you will need to enter the 

total area (from Table 2). Remember to substract the areas of doors and windows of the 

wall area!. The other coefficients will be explained in the next section. 

 

For each wall you have to define the number of layers. The order of layers appears in the 

legend in the top “Layer 1 faces:” (it depends on the order you selected in the 

connections, so it can be different from one wall to the other). For each layer, you have to 

indicate if the layer has thermal mass (yes/no, si/no in Spanish). You must select “no” only 

for layers of thermal insulation, otherwise select “si”. Also you will must enter the layer 

thickness, the layer thermal properties (thermal conductivity, density, and specific heat at 

constant pressure, you have a list of materials if you ), and the number of internal points 

you want to calculate in each layer (usually one point every 4-5 cm). Remember that, 

because of the physical model, the first and last layer must have thermal mass.  

 

4.3.2. DOOR AIR MIXING: doors, in the colloquial sense of the word, have two functions: 1- 

exchange of air between two rooms (when open), which is simulated by the DOOR 

element in SIMEDIF; and 2- surface that avoids the air exchange (when closed), which is 

simulated by a PARTITION in SIMEDIF. That is, when a door is closed most of the time (as 
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would be the case of a main door in the entrance of a house), in SIMEDIF it is preferable to 

define it as a PARTITION. While for a door that most of the time is open (partially or 

totally) and it allows the air exchange, then you have to define it as a DOOR element in 

SIMEDIF (always remember that, in SIMEDIF, the DOOR and VENT elements are related 

with the exchange of air). In our example, we will consider that the door connecting the 

Bedroom/Bathroom with the Living_room is half open most of the time, allowing the 

convective exchange between the two THERMAL ZONES, so it is simulated as DOOR D1 

(for which you must enter the height, the width, the discharge coefficient that is usually 

0.6, and the timing of opening and closing the door). The door in the house entrance is 

closed most of the time, so it will be considered as a NON MASSIVE element (N4). 

 

4.3.3. PARTITIONS: besides PARTITION N4 corresponding to the door in the house 

entrance, there are other constructions that do not accumulate heat (materials with poor 

thermal mass). These are: the interior partition of gypsum board that separates the 

Bedroom/Bathroom from the Living_room (N1) and the ceilings of both THERMAL ZONES 

(N2 and N3, made of metal + thermal insulation + wood). For PARTITIONS you need to 

enter: the total area, the coefficient of solar absorption, the heat transfer coefficient 

(explained later) and the thermal conductance C (that is, thermal conductivity/thickness). 

 

In this case, the PARTITION N1 corresponds to a gypsum board (27mm thick) + air camera 

(50mm) + gypsum board (27mm thick). The thermal conductivity of the gypsum board is 

0.58 W/m-K. Because it is 3-layered, the global thermal conductance Ctotal is calculated as: 

 

1/Ctotal=1/Cgypsum + 1/Cair + 1/Cgypsum 

 

Thus, Ctotal= (0.027/0.58 + 0.05/ 0.025+ 0.027/0.58)
-1

 W/m
2
-K= 0.48 W/m

2
-K. 

 

The PARTITIONS N2 and N3 are three-layered: galvanized sheet (thickness 0.7 mm, 

thermal conductivity thermal 58 W/m-K) with thermal insulation of expanded polystyrene 

(45mm thick, thermal conductivity 0.041 W/m-K) and pine wood roofing (25mm thick, 

thermal conductivity 0.153 W/m-K). Following the same procedure for the calculation of 

the thermal conductance previously described, the obtained value is Ctotal=0.79 W/m
2
-K. 

The PARTITION N4 corresponds to a wooden plate 45 mm thick, thermal conductivity 

0.153 W/m-K, and thermal conductance of 3.4 W/m-K. 

 

4.3.4. GLAZING: in the example there are two double glazed windows, G1 and G2, with 

shutters for darkening (it is assumed that they are closed at night), so that heat transfer 

will be different during the day (when the heat passes only through the double glazing) 

than during the night (when heat passes through the double glazing and the shutters). 

Therefore, two values for the heat transfer coefficients (U-value) must be defined, one for 

the day and one for the night. The common value of U-value for a double glazing is around 

3.3 W/m-K, while for double glazing plus wood shutters is around 2.8W/m-K. The exact 

values depend on the materials and they are provided by the manufacturer. 
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It is important to note that a window has two functions in a building: it allows the solar 

radiation to enter, it allows the outdoor air to enter, and it is an element of heat transfer 

between outdoors and indoors. In SIMEDIF the functions of a building are separately 

entered: solar radiation is accounted for via the ORIENTATION INDICATORS, air flow 

coming from outdoors (ventilation) is accounted for via the air renewals value defined for 

the THERMAL ZONE or via the definition of a DOOR element. Only the third function is 

accounted for by the GLAZING element. 

 

Until this point in our example, we have not included the solar radiation coming through 

the windows G1 and G2 and entering to the Living_room and the Bedroom/Bathroom. 

This will be done when we define the ORIENTATION INDICATORS (explained later). As in 

our example we considered a winter period, it is assumed that the windows are closed, so 

we have not added a ventilation function for them. If it was summer and the windows are 

open permanently, we might consider entering the outside air by the number of air 

changes. If they were open, say, 8 to 10 am, we could enter this ventilation through a door 

element D2 with those hours of opening and closing. 

 

4.3.5. VENTS AND WATER WALLS: in this example these elements are not used. Whenever 

an item is not used, you must delete all them that appear on the list by default. If you 

forget do this, when you control the files (Run-> File Control), the software will indicate 

which elements should be deleted. 

 

4.3.6. ENTERING THE DIRECT SOLAR HEAT GAINS: ORIENTATION INDICATORS, SUNLIT 

AREA AND SOLAR ABSORPTIVITY 

 

ORIENTATION INDICATORS 

At this point, the orientation of the building has not been considered at all. Orientation is 

important for solar radiation. For example, in the South hemisphere, a MASSIVE WALL 

oriented towards the North receives more solar radiation than other oriented towards the 

South. Because the data entry in SIMEDIF is not graphical, we have to indicate manually 

the orientation of each element. This orientation together with the number of transparent 

covers the radiation overpasses until reaching certain surface, are described by the 

ORIENTATION INDICATORS. Thus, the software calculates the solar radiation that reaches 

the different surfaces depending on their orientation. This calculation uses the hourly 

global horizontal, diffuse and direct solar radiation data (read from the weather file). For 

defining an ORIENTATION INDICATOR you must enter: the slope of the surface (from 0º to 

90º), the azimuth of the surface (0º towards South, 90º towards East, 180º towards North, 

and 270º towards West), the albedo, and the number of transparent covers. For example: 

a MASSIVE WALL oriented to North, on the outside, we will define the ORIENTATION 

INDICATOR Nº1, with slope 90º, azimuth 180º, albedo 0.3 (surroundings covered by grass), 

and Number of transparent covers 0. This ORIENTATION INDICATOR can be used for all 



 
25 

 

the elements with the same configuration (for example, a PARTITION oriented towards 

North, another MASSIVE WALL with the same orientation, etc.). 

 

A MASSIVE (or NON MASSIVE) WALL can be illuminated in one or in its two sides (for 

example, an exterior wall with a window in front of it that illuminates the interior side of 

the wall). Thus, the ORIENTATION INDICATORS must be defined for both sides of the 

element. In our example, all the exterior walls (M1, M2, M3, M5, M6 and M7), ceilings (N2 

and N3) and the entrance wood door (N4) receive solar radiation (the software will 

calculate how much radiation affects each one depending on your orientation). The 

radiation entering through G1 and G2 falls mainly on the floors (this is an assumption, an 

average on the day), that is, the radiation entering through the GLAZING G1 reaches M8 

(on its interior side) and the solar radiation entering through G2 reaches M4 (on its 

interior side). With this data, we can construct the following table (it is suggested to 

analyze carefully how the index for the walls M4 and M8 are defined): 

 

Element Element side 

where solar 

radiation 

impings 

Slope Azimuth Albedo Number of 

transparent 

covers 

M1 Outside 90 180 (North) 0.3 0 

M2 Outside 90 0 (South) 0.3 0 

M3 Outside 90 270 (West) 0.3 0 

M4 Inside 

(Bedroom/Bathr

oom) 

90 270 (West) 0.3 2 

M5 Outside 90 180 (North) 0.3 0 

M6 Outside 90 90 (East) 0.3 0 

M7 Outside 90 0 (South) 0.3 0 

M8 Inside 

(Living_room) 

90 180 (North) 0.3 2 

N2 Outside 0 No matter 0.3 0 

N3 Exterior 0 No matter 0.3 0 
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N4 Exterior 90 90 (East) 0.3 0 

Table 3: elements of the example that are illuminated by the sun. 

 

Of course, when the slope is 0, it does not matter which value is chosen for the azimuth 

(here we use Azimuth=0). The albedo depends on the reflectance of the surroundings. 

Finally, if you compare the last four columns you will detect repeated elements (in this 

case, M1 and M5 will use the same ORIENTATION INDICATOR; the same applies to M2 and 

M7, and to M6 and N4). In our case, six ORIENTATION INDICATORS will be defined, which 

can be seen in Table 4. 

 

ORIENTATION 

INDICATOR 

Slope Azimuth Albedo Nº of covers It is applied 

to: 

1 90 180 0.3 0 M1, M5 

2 90 0 0.3 0 M2, M7 

3 90 270 0.3 0 M3 

4 90 270 0.3 2 M4 

(interior) 

5 90 90 0.3 0 M6, N4 

6 90 180 0.3 2 M8 

(interior) 

7 0 0 0.3 0 N2, N3 

Table 4: ORIENTATION INDICATORS defined for the example on Fig. 1. 

SUNLIT AREA 

The sunlit area in the case of exterior surfaces exposed to solar radiation is the surface 

area considered, as long as there are no objects around the shade the surface, as large 

trees or other buildings. In the case of internal surfaces where radiation is reached after it 

crosses a glazing panel, the sunlit area is the area of the glazing. For example, we will 

assume that all solar radiation entering through the GLAZING G2 of 2m
2
, will reach M4 - 
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Bedroom side. Thus the sunlit area of M4-Bedroom side, is 2m
2
. Similarly, for P8 – 

Living_room we will define a sunlit area of 2m
2
. 

ABSORPTION COEFFICIENTS 

Absorption coefficients depend on the color of the surface and they can be obtained from 

tables in the literature. In our example, for the Bedroom floor and the Living_room floor 

we will use an absorption coefficient of 0.7 (gray cement). For the exterior walls made of 

solid brick (without plastering) we will use 0.6 (brown-orange). In the case of N2 and N3, 

we will use an absorption coefficient of 0.3 (assuming the metal sheet is painted with a 

light color). 

Surfaces of MASSIVE and PARTITIONS that do not receive radiation also must have 

assigned an ORIENTATION INDICATOR, only to avoid crashing of the software. In fact, you 

can use any of the predefined ORIENTATION INDICATORS together with a zero sunlit area. 

Thus, for N1 we will use any index (for example 1), with sunlit area equaling zero. 

 

4.3.7. ENTERING THE CONVECTIVE/RADIATIVE COEFFICIENT h 

You must define the convective/radiative coefficients for inside and outside surfaces of 

WALLS (MASSIVE and NON MASSIVE). This coefficient is related to air velocity v. There are 

several correlations to estimate this coefficient. For plane surfaces, it is usually calculated 

from the Duffie-Beckman (1991) relationship h = 5.7 + 3.8v, where v is the air velocity in 

m/s, but you can use any other correlation of the literature. In this example, we will use 

convective/radiative coefficients of 6 W/m
2
-K (for interior surfaces that do not receive 

solar radiation), 8 W/m
2
-K (for interior surfaces heated by direct solar radiation), and 10 

W/m
2
-K (for external surfaces, corresponding to an average wind speed in June in Salta of 

about 2.5 m/s). Remember that for outside surface of the floor (it is a ficticious concept 

because you have 1m of ground), we will use a low coefficient, say 0.1 W/m
2
-K (in fact, 

this value should be zero, but in this case the software gives an error message of “Division 

by zero”). 

Then, the elements have the coefficients shown in Tables 5 to 10. 

MASSIVE 

WALL 
Side 

Solar 

Absorption 

coeff. 

h  

(W/m
2
-K) 

ORIENTATION 

INDICATOR 

Sunlit 

area (m
2
) 

Area 

(m
2
) 

Nº of 

layers 

M1 Outside 0.6 10 1 7.5 7.5 3 
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Inside 

(Bedroom) 

0.6 

(Anyone) 

6 1 (Anyone) 0 

M2 

Outside 0.6 10 2 7.5 

7.5 3 Inside 

(Bedroom) 

0.6 

(Anyone) 

6 2 (Anyone) 0 

M3 

Outside 0.6 10 3 8.5 

8.5 3 Inside 

(Bedroom) 

0.6 

(Anyone) 

6 3 (Anyone) 0 

M4 

Outside 0.7 

(Anyone) 

0.1 4 (Anyone) 0 

12 3 

Inside 

(Bedroom) 

0.7 8 4 1.5 

M5 

Outside 0.6 10 1 9.5 

9.5 3 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 1 (Anyone) 0 

M6 

Outside 0.6 10 5 (Anyone) 8.4 

8.4 3 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 5 (Anyone) 0 

M7 

Outside 0.6 10 2 12.5 

12.5 3 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 2 (Anyone) 0 

M8 

Outside 0.7 

(Anyone) 

0.1 6 (Anyone) 0 

20 3 Inside 

(Living_roo

m) 

0.7 8 6 3 

Table 5: Data entry for MASSIVE WALLS. 
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PARTITIO

N 
Side 

Solar 

Absorption 

coeff. 

h  

(W/m
2
-K) 

ORIENTATION 

INDICATOR 

Sunlit 

area 

(m
2
) 

Area 

(m
2
) 

Thermal 

transmitta

nce. 

N1 

Inside 

(Bedroom) 

0.6 

(Anyone) 

6 1 (Anyone) 0 

8.4 18 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 1 (Anyone) 0 

N2 

Outside 0.3 10 7 12 

12 0.8 Inside 

(Bedroom) 

0.6 

(Anyone) 

6 7 (Anyone) 0 

N3 

Outside 0.3 10 7 20 

20 0.8 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 7 (Anyone) 0 

N4 

Outside 0.6 10 5 1.6 

1.6 3.6 Inside 

(Living_roo

m) 

0.6 

(Anyone) 

6 5 (Anyone) 0 

Table 6: Data entry for PARTITIONS. 

 

GLAZING Connecting Area (m
2
) U-value (day) U-value (night) 

G1 Outdoors-

Living_room 

3 3.3 3.3 

G2 Outdoors- 

Bedroom 

1.5 3.3 2.8 

Table 7: Data entry for GLAZING. 

 



 
30 

 

DOOR Connecting Height (m) Width (m) Discharge Coeff. 

D1 Bedroom-

Living_room 

2 0.8 0.6 

Table 8: Data entry for DOORS. 

 

MASSIVE 

WALL 

Nº of 

layer 

With 

mass? 
k (W/m-K) 

Thickness 

(m) 
ρ (kg/m

3
) Cp (J/kg) 

Nº of internal 

points to 

simulate 

M1, M2, 

M3, M5, 

M6, M7 

1 Yes 0.9 0.12 1800 1130 2 

2 No 0.04 0.05 - - - 

3 Yes 0.9 0.12 1800 1130 2 

M4, M8 

1(ext) Yes 0.6 1.00 1600 1130 10 

2 No 0.04 0.05 - - - 

3 Yes 1.7 0.10 2400 1080 2 

Tabla 9: Data entry of MASSIVE WALL layers. 

If you are here, congratulations!! You finally finished the data entry. 

6.4. Step 4: Make calculation. 

The last step is to perform the calculation (look for it in the Toolbar menu). Before starting 

the mathematical calculations, the software checks the input data, to detect typing errors 

or null/empty values. Then a new screen appears, asking the user about the initial 

temperatures to start the calculation (usually the average outside temperature, which in 

this case is 10.4ºC is entered), the internal gains of each local in W (in this case we do not 

consider the internal gains ), the number of time steps to divide one hour (a message in 

the frame below indicates an approximate value for this box), and the opening and closing 

hours of shutters of the windows (by default, open at 8 and close to 22). Then click on 

Calculate button. A plot will be shown with the results. You can open the results file (*.res) 

with Excel or with a text editor. 


